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Warranty
The CAN hardware is warranted against defects in materials and workmanship for a period of one year from th
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or r
equipment that proves to be defective during the warranty period. This warranty includes parts and labor. 

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evid
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that 
execute programming instructions if National Instruments receives notice of such defects during the warranty pe
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outs
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully re
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the 
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any dam
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL  INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS 
ANY WARRANTY OF MERCHANTABILITY  OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’ S RIGHT TO RECOVER DAMAGES CAUSED 
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL  INSTRUMENTS SHALL BE LIMITED  TO THE AMOUNT THERETOFORE PAID BY THE 
CUSTOMER. NATIONAL  INSTRUMENTS WILL  NOT BE LIABLE  FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, 
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of 
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.
Any action against National Instruments must be brought within one year after the cause of action accrues. Natio
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The wa
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to 
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third partie
or other events outside reasonable control.

Copyright
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mecha
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, wit
the prior written consent of National Instruments Corporation.

Trademarks
CVI™, LabVIEW™, natinst.com™, and NI-CAN™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS
National Instruments products are not designed with components and testing intended to ensure a level of reliab
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving m
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part
user or application designer. Any use or application of National Instruments products for or involving medical or cl
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeg
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should
continue to be used when National Instruments products are being used. National Instruments products are NOT i
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard huma
and safety in medical or clinical treatment.



 
  FCC/DOC Radio Frequency Interference 

Class A Compliance

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance 
with the instructions in this manual, may cause interference to radio and television reception. Classification 
requirements are the same for the Federal Communications Commission (FCC) and the Canadian 
Department of Communications (DOC). This equipment has been tested and found to comply with the 
following two regulatory agencies:

Federal Communications Commission
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a 
residential area is likely to cause harmful interference in which case the user will be required to correct the 
interference at his own expense.

Notices to User: Changes or modifications not expressly approved by National Instruments could void 
the user’s authority to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables 
of suitable quality and construction. National Instruments used such cables to test 
this device and provides them for sale to the user. The use of inferior or nonshielded 
interface cables could void the user’s authority to operate the equipment under the 
FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional 
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home 
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government 
Printing Office, Washington, DC 20402.

Canadian Department of Communications
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations.
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur 
du Canada.
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This manual contains instructions to help you install and configure the
National Instruments CAN hardware and the NI-CAN software for 
Windows NT. The National Instruments CAN hardware supported und
Windows NT includes the PCI-CAN, PCI-CAN/2, PCMCIA-CAN, and 
PCMCIA-CAN/2.

This manual assumes that you are already familiar with Windows NT.

How to Use the Manual Set

Use this getting started manual to install and configure your CAN hardw
and the NI-CAN software for Windows NT.

Use the NI-CAN User Manual for Windows 95 and Windows NT to learn 
the basics of CAN and how to develop an application program. The us
manual also contains debugging information and detailed examples.

NI-CAN
User Manual

for Windows 95
and Windows NT

Application
Development
and Examples

Novice
Users

Experienced
Users

NI-CAN Programmer
Reference Manual

for Win32

Function
and Object

Descriptions

Getting Started
Manual

Installation and
Configuration
© National Instruments Corporation ix Getting Started with CAN for Windows NT
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Use the NI-CAN Programmer Reference Manual for Win32 for specific 
information about each NI-CAN function and object, such as format, 
parameters, and possible errors.

Organization of This Manual
This manual is organized as follows:

• Chapter 1, Introduction, explains how to use this manual, lists what 
you need to get started and optional equipment you can order, an
briefly describes the CAN hardware and the NI-CAN software for 
Windows NT.

• Chapter 2, Installation and Configuration, describes how to install 
and configure the CAN hardware and the NI-CAN software for 
Windows NT.

• Chapter 3, Verify the Installation, describes how to verify the hardware
and software installation.

• Chapter 4, Begin to Use the NI-CAN Software, helps you get started 
with the NI-CAN software for Windows NT.

• Appendix A, Uninstall the Hardware and Software, describes how 
to uninstall the CAN hardware and the NI-CAN software from 
Windows NT.

• Appendix B, Cabling Requirements, describes the cabling 
requirements for CAN interfaces.

• Appendix C, Troubleshooting and Common Questions, describes how 
to troubleshoot problems and answers some common questions.

• Appendix D, Specifications, describes the physical characteristics o
the CAN hardware, along with the recommended operating conditio

• Appendix E, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our produ
and manuals.

• The Glossary contains an alphabetical list and a description of term
used in this manual, including abbreviations, acronyms, metric 
prefixes, mnemonics, and symbols.
Getting Started with CAN for Windows NT x © National Instruments Corporation
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Conventions Used in This Manual
The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box op
to a final action. The sequence File»Page Setup»Options»Substitute 
Fonts directs you to pull down the File menu, select the Page Setup item, 
select Options, and finally select the Substitute Fonts option from the last 
dialog box.

This icon to the left of bold italicized text denotes a note, which alerts y
to important information.

This icon to the left of bold italicized text denotes a caution, which advis
you of precautions to take to avoid injury, data loss, or a system crash

bold Bold text denotes the names of menus, menu items, parameters, dialo
boxes, dialog box buttons or options, icons, windows, Windows NT tab
or LEDs.

bold italic Bold italic text denotes a note or caution.

CAN hardware CAN hardware refers to the PCI-CAN, PCI-CAN/2, PCMCIA-CAN, and
PCMCIA-CAN/2 in cases where the material applies to all the interfac

italic Italic text denotes emphasis, a cross reference, or an introduction to a
concept. This font also denotes text for which you supply the appropri
word or value, such as in Windows 3.x.

monospace Text in this font denotes text or characters that you should literally ent
from the keyboard, sections of code, programming examples, and syn
examples. This font is also used for the proper names of disk drives, pa
directories, programs, subprograms, subroutines, device names, funct
operations, variables, filenames, and extensions, and for statements a
comments taken from program code.

monospace italic Italic text in this font denotes that you must supply the appropriate wor
or values in the place of these items.

paths Paths in this manual are denoted using backslashes (\) to separate d
names, directories, folders, and files.

!

© National Instruments Corporation xi Getting Started with CAN for Windows NT
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Related Documentation
The following documents contain information that you may find helpful 
you read this manual:

• ANSI/ISO Standard 11898-1993, Road Vehicles—Interchange of 
Digital Information—Controller Area Network (CAN) for High-Spee
Communication

• CAN Specification Version 2.0, 1991, Robert Bosch Gmbh., 
Postfach 500, D-7000 Stuttgart 1

• CiA Draft Standard 102, Version 2.0, CAN Physical Layer for 
Industrial Applications

• DeviceNet Specification, Volume 1, Version 2.0, Open DeviceNet 
Vendor Association

• Microsoft Windows NT User’s Guide, Microsoft Corporation

Customer Communication
National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with o
products, and we want to help if you have problems with them. To mak
easy for you to contact us, this manual contains comment and configura
forms for you to complete. These forms are in Appendix E, Customer 
Communication, at the end of this manual. 
Getting Started with CAN for Windows NT xii © National Instruments Corporation
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Introduction

This chapter explains how to use this manual, lists what you need to g
started and optional equipment you can order, and briefly describes th
CAN hardware and the NI-CAN software for Windows NT.

How to Use This Manual

Yes

No

Chapter 3

Chapter 4

User Manual and
Programmer Reference

Manual
Write Application Program

Passes?

Gather What You Need
to Get Started

Chapter 1

Install the Hardware

Install the Software

Verify the Installation

Review Programming
Considerations

Troubleshooting
Appendix

Configure the Software

Chapter 2
 for Windows NT



Chapter 1 Introduction

tall 

T 

h 

 

th 

he 
What You Need to Get Started
Make sure you have all of the following items before you attempt to ins
the hardware and software:

❑ Windows NT 3.51 or later installed on your computer

❑ One of the following CAN interfaces, which is included in your kit:

PCI-CAN
PCI-CAN/2
PCMCIA-CAN
PCMCIA-CAN/2

❑ The following 3.5 in., high-density (1.44 MB) disks, which are 
included in your kit:

NI-CAN Software for Windows 95 and Windows NT (Disk 1)

NI-CAN Software for Windows 95 and Windows NT (Disk 2)

❑ PCMCIA-CAN cable, which is included in your kit, if you have a 
PCMCIA-CAN or PCMCIA-CAN/2

❑ CAN interface cables that meet the requirements in Appendix B, 
Cabling Requirements

CAN Hardware Overview
The National Instruments CAN hardware supported under Windows N
includes the PCI-CAN, PCI-CAN/2, PCMCIA-CAN, and 
PCMCIA-CAN/2

The PCI-CAN and PCI-CAN/2 are completely software configurable 
and compliant with the PCI Local Bus Specification. With a PCI-CAN 
or PCI-CAN/2 board, you can make your PC-compatible computer wit
PCI Local Bus slots communicate with and control CAN devices.

The PCMCIA-CAN and PCMCIA-CAN/2 are Type II PC Cards that are
completely software configurable and compliant with the PCMCIA 
standards for 16-bit PC Cards. With a PCMCIA-CAN card or 
PCMCIA-CAN/2 card, you can make your PC-compatible notebook wi
PCMCIA sockets communicate with and control CAN devices.

The PCI-CAN and PCMCIA-CAN interfaces each have one CAN port. T
PCI-CAN/2 and PCMCIA-CAN/2 interfaces each have two CAN ports.
Getting Started with CAN for Windows NT 1-2 © National Instruments Corporation
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CAN interfacing is accomplished using the Intel 82527 CAN controller
chip. The PCI-CAN physical layer fully conforms to the ISO 11898 
physical layer specification for CAN and is optically isolated to 500 V. 
PCI-CAN boards are available with two physical connector types: DB-
D-Sub and Combicon-style pluggable screw terminals. PCMCIA-CAN
cables include both a DB-9 D-Sub and a Combicon-style pluggable sc
terminal.  The CAN physical layer on PCI-CAN cards can be powered
either internally (from the card) or externally (from the bus cable powe
The power source for the CAN physical layer for each port is configure
with a jumper.  There are two cables available for the PCMCIA-CAN car
In one cable the CAN physical layer is powered internally (from the car
In the other cable the CAN physical layer is powered externally (from 
bus cable power). The CAN hardware supports a wide variety of trans
rates up to 1 Mb/s.

All of the CAN hardware uses the Intel 386EX embedded processor to
implement time-critical features provided by the NI-CAN software. The
CAN hardware communicates with the NI-CAN driver through on-boar
shared memory and an interrupt.

NI-CAN Software Overview
The NI-CAN software includes a native, 32-bit multitasking Windows N
kernel driver.

The NI-CAN software for Windows NT supports the concurrent use of 
multiple types of CAN hardware. For example, you can communicate w
CAN devices through both a PCI-CAN and PCI-CAN/2 in the same syst
at the same time. The NI-CAN software is fully integrated into the 
Windows NT operating system. It is configurable through the Windows N
Control Panel and uninstallable through the Add/Remove Programs ap
of the Control Panel.

The NI-CAN software, along with the CAN hardware, transforms your 
computer into a CAN interface with complete communications and bus
management capability. The NI-CAN software includes the following 
components:

• Firmware (runs on embedded Intel 386EX)

• Device driver

• Diagnostic test utility

• Configuration utility
© National Instruments Corporation 1-3 Getting Started with CAN for Windows NT
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• Language interface libraries for Microsoft Visual C/C++ 2.0 or late
LabWindows/CVI 4.0 or later, and LabVIEW 4.0 or later

• Example programs that use NI-CAN functions

Optional Programming Tools
Your kit includes the NI-CAN software for Windows NT. In addition, 
you can order the LabWindows/CVI or LabVIEW software from Nation
Instruments.

LabWindows/CVI is an interactive ANSI C development environment f
building test and measurement and instrument control systems. It inclu
interactive code-generation tools and a graphical editor for building cus
user interfaces. It also includes built-in libraries for IEEE 488.2, VXI, 
RS-232 control, and plug-in data acquisition. When you order 
LabWindows/CVI, you also get hundreds of complete instrument drive
which are modular, source-code programs that handle the communica
with your instrument so that you do not have to learn the programming
details.

LabVIEW is a complete programming environment that departs from t
sequential nature of traditional programming languages and features a
graphical programming environment. It includes all the tools needed fo
instrument control, data acquisition, analysis, and presentation. LabVI
also includes an extensive instrument driver library.

For more information about LabWindows/CVI and LabVIEW, contact 
National Instruments.
Getting Started with CAN for Windows NT 1-4 © National Instruments Corporation
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Installation and Configuration

This chapter describes how to install and configure the CAN hardware 
the NI-CAN software for Windows NT.

Install the NI-CAN Software
Before installing the CAN hardware, complete the following steps to ins
the NI-CAN software for Windows NT.

Installing for Windows NT 3.51
1. Log in as Administrator  or as a user that has Administrator 

privileges.

2. Insert the NI-CAN Software for Windows 95 and Windows NT (Disk 
into an unused drive.

3. In the Run dialog box, type the following:

x:\setup

where x  is the letter of the drive containing the disk (usually a or b).

4. Shut down your computer when the setup is complete.

Installing for Windows NT 4.0
1. Log in as Administrator  or as a user that has Administrator 

privileges.

2. Select Start»Settings»Control Panel.

3. Double-click on the Add/Remove Programs icon in the Control Panel 
to launch the Add/Remove Programs applet. A dialog box similar 
the one in Figure 2-1 appears.
 for Windows NT
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Figure 2-1.  Add/Remove Programs Properties Dialog Box

You can use this same applet to uninstall the NI-CAN software 
at a later time. Refer to Appendix A, Uninstall the Hardware 
and Software, for more information.

4. Click on the Install  button.

5. Insert the NI-CAN Software for Windows 95 and Windows NT (Disk 1, 
and click on the Next button to proceed. The software installation 
wizard begins with the screen shown in Figure 2-2.
Getting Started with CAN for Windows NT 2-2 © National Instruments Corporation
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Figure 2-2.  NI-CAN Software Setup Screen

The setup wizard guides you through the necessary steps to insta
the NI-CAN software. You may go back and change values where
appropriate by clicking on the Back button. You can exit the setup 
where appropriate by clicking on the Cancel button.

6. Shut down your computer when the setup is complete.

Install the CAN Hardware
This section describes how to install your CAN hardware.

Install Your PCI-CAN or PCI-CAN/2

Caution Electrostatic discharge can damage several components on these CAN interfa
To avoid such damage in handling your interface, touch the antistatic plastic 
package to a metal part of your computer chassis before removing the interfac
from the package.

1. Make sure that your computer is turned off. Keep the computer 
plugged in so that it remains grounded while you install the CAN 
interface.

2. Remove the top cover (or other access panels) to give yourself ac
to the computer expansion slots.

!

© National Instruments Corporation 2-3 Getting Started with CAN for Windows NT
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3. Find an unused expansion slot of the appropriate type in your 
computer.

4. Remove the corresponding slot cover on the back panel of the 
computer.

5. Insert the CAN interface into the slot with the CAN connector(s) 
sticking out of the opening on the back panel. It might be a tight fit, b
do not force the interface into place. Figure 2-3 shows how to insta
the PCI-CAN into a PCI expansion slot.

Figure 2-3.  Installing the PCI-CAN

6. Screw the mounting bracket of the CAN interface to the back panel
of the computer.

7. Replace the top cover (or the access panel to the expansion slot).

8. Turn on your computer and start Windows NT. 

When you have finished installing the hardware, proceed to the Connect the 
Cables section, later in this chapter.
Getting Started with CAN for Windows NT 2-4 © National Instruments Corporation
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Install Your PCMCIA-CAN or PCMCIA-CAN/2

Caution Electrostatic discharge can damage several components on these CAN interfa
To avoid such damage in handling your interface, touch the antistatic plastic 
package to a metal part of your computer chassis before removing the interfac
from the package.

Note Because of restrictions imposed by Windows NT, only one PCMCIA-CAN or 
PCMCIA-CAN/2 can be used in a given Windows NT system. For example, if y
have a PCMCIA-CAN card in your system, you cannot use a PCMCIA-CAN/2 
card at the same time.

1. Shut down your operating system and power off your system.

2. Insert the card into a free PC Card (PCMCIA) socket. The card ha
jumpers or switches to set. Figure 2-4 shows how to insert the card
how to connect the PCMCIA-CAN cable and connector to the card

Figure 2-4.  Inserting the PCMCIA-CAN

!

PCMCIA-CAN
Cable

PCMCIA
Socket

Portable
Computer
© National Instruments Corporation 2-5 Getting Started with CAN for Windows NT
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3. Connect the PCMCIA-CAN cable to the card.

4. Power on your computer.

When you have finished installing the hardware, proceed to the next 
section, Connect the Cables.

Connect the Cables
Because exact cabling requirements will vary for each application, 
National Instruments does not provide cables, other than the 
PCMCIA-CAN cable. Refer to Appendix B, Cabling Requirements, 
for information about the cabling requirements of the CAN hardware.

After you have installed the CAN interface, connect your CAN cables 
the interface. The CAN hardware installation is now complete. Procee
to the next section, Configure the NI-CAN Software.

Configure the NI-CAN Software
The NI-CAN Configuration utility is located in the Windows NT Contro
Panel. You can use it to examine or modify the configuration of the 
NI-CAN software. The context-sensitive online help, available by 
right-clicking on any of the controls on the configuration utility buttons,
includes all of the information that you need to configure the NI-CAN 
software properly.

To use the NI-CAN Configuration utility, you must first log in as 
Administrator  or as a user that has Administrator privileges. To 
configure the NI-CAN software, double-click on the NI-CAN 
Configuration  icon in the Control Panel:

• Windows NT 3.51:  Open the Control Panel in the Main group of the 
Program Manager.

• Windows NT 4.0 or later:  Select Start»Settings»Control Panel.

Figure 2-5 shows a CAN interface that is working properly. If no interfac
are listed under NI-CAN Configuration , refer to the Missing CAN 
Interface in the NI-CAN Configuration Utility section in Appendix C, 
Troubleshooting and Common Questions, to resolve the problem.
Getting Started with CAN for Windows NT 2-6 © National Instruments Corporation
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Figure 2-5.  CAN Interface That Is Working Properly

To select a particular interface, click on that interface in the list.

When you install a PCI-CAN interface, your computer automatically 
assigns valid resources to it. Because this resource assignment is auto
you do not need to use the Resources dialog box for the PCI-CAN, and you
do not need to restart Windows NT.

When you install a PCMCIA-CAN interface, your computer assigns 
default resources to it. Because the default resources may conflict wit
other devices in your system, you must use the Resources dialog box to 
select valid resources for the PCMCIA-CAN. Figure 2-6 shows the 
Resources dialog box for the PCMCIA-CAN.

Figure 2-6.  Resources Dialog Box for the PCMCIA-CAN

Click on the Settings button to view information about the NI-CAN 
software configuration for the CAN interface. Figure 2-7 shows the 
Settings dialog box.
© National Instruments Corporation 2-7 Getting Started with CAN for Windows NT
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Figure 2-7.  NI-CAN Settings for the PCI-CAN/2

Each port of the CAN hardware interface is configured from this tab. U
the drop-down box nearest the top of the tab to select the physical po
number to configure. For each port, use the Name drop-down box to select 
the name for the CAN Network Interface Object (CAN0, CAN1, and so on). 
You use this name to refer to the physical port from within your NI-CA
application. 

To access online help for the NI-CAN Configuration utility, click on the
Help button. Alternately, you can right-click on a specific control and 
select What’s This? from the pop-up menu to see context-sensitive hel
for the item you have clicked on.

When you have finished configuring the NI-CAN software, proceed to 
Chapter 3, Verify the Installation.

Note If you changed the resources for any PCMCIA-CAN or PCMCIA-CAN/2 
interface, you must restart Windows NT for the changes to take effect.
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Verify the Installation

This chapter describes how to verify the hardware and software 
installation.

You can use the NI-CAN Diagnostic utility, installed with your NI-CAN 
software, to test the hardware and software installation. The utility verif
that your hardware and software are functioning properly and that the 
configuration of your CAN interfaces does not conflict with anything el
in your system.

To run the utility, select the NI-CAN Diagnostic item:

• Windows NT 3.51:  Double-click on the NI-CAN Diagnostic icon in 
the NI-CAN Software for Windows NT group of the Program 
Manager.

• Windows NT 4.0 or later: Select Start»Programs»NI-CAN Software 
for Windows NT»NI-CAN Diagnostic.

When you have started the NI-CAN Diagnostic utility, test your CAN 
interfaces by clicking on the Test All button. You can also test one CAN 
interface by highlighting it and clicking on the Test One button. If the 
NI-CAN Diagnostic is successful, it puts a checkmark next to the interfa
and changes its status from Untested to Passed. If the NI-CAN Diagnostic 
fails, it puts an X next to the interface, and changes its status from Untested 
to Failed. Figure 3-1 shows the NI-CAN Diagnostic utility after it has 
tested some CAN interfaces.
 for Windows NT
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Figure 3-1.  NI-CAN Diagnostic Utility after Testing

You can get details about any tested CAN interface by selecting the 
interface and clicking on the Details button. For each failed CAN interface,
select it and click on the Details button to get a description of the failure.
Use that information and the information in Appendix C, Troubleshooting 
and Common Questions, to troubleshoot the problem. Troubleshooting 
information is also available in the online help for the NI-CAN Diagnost
utility, which you can access by clicking on the Help button.
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Begin to Use the 
NI-CAN Software

This chapter helps you get started with the NI-CAN software for 
Windows NT.

Using the NI-CAN Software
The functions provided by the NI-CAN software are similar to those 
provided by many other device drivers. For example, NI-CAN has ope
close, read, and write functions. NI-CAN provides two different levels 
access to a CAN network: the CAN Network Interface Object and CAN
Objects. Both forms of access support timestamping of incoming data
well as various forms of queuing.

The CAN Network Interface Object provides low-level access to a CAN
network. Each CAN Network Interface Object maps to a specific CAN
port, with no limitation on the maximum number of ports or cards you c
use (for example, two PCI-CAN/2 interfaces would provide CAN0 through 
CAN3). You can use this object to transmit and receive entire CAN fram
For example, to transmit a CAN frame, you would specify the outgoing
arbitration ID, frame type (data or remote), data length, and data.

The CAN Objects provide higher level access to a CAN network. Each
CAN Object maps to a specific data item (arbitration ID), and you can 
multiple CAN Objects for a given port. When configuring a CAN Objec
for use, you specify the arbitration ID, direction of data transfer, data 
length, and how you want the data to be accessed (such as periodical
For example, you could configure a CAN Object to transmit an outgoin
data frame for a specific arbitration ID every 100 ms. After opening thi
CAN Object, you use the write function to provide data to transmit, and 
NI-CAN embedded firmware handles all periodic timing. 

For detailed information about the NI-CAN software and functions, ref
to the NI-CAN User Manual for Windows 95 and Windows NT and the 
NI-CAN Programmer Reference Manual for Win32.
 for Windows NT
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General Programming Considerations
As you begin developing your Win32 NI-CAN application, remember th
following points:

• For your LabVIEW application, you must use the NI-CAN LabVIEW
functions in nican.llb . 

• For your C/C++ application, you must include the NI-CAN header fil
nican.h , in your source code. 

• The NI-CAN software is accessed through the 32-bit DLL, 
nican.dll , either by linking with one of the language interfaces 
provided with the NI-CAN software, or by using direct DLL entry 
from other programming environments.

• Several sample CAN applications are included with the NI-CAN 
software. Use these as a guide for your own application developm

For information about developing your application, refer to the NI-CAN 
User Manual for Windows 95 and Windows NT. For detailed information 
about NI-CAN functions and objects, refer to the NI-CAN Programmer 
Reference Manual for Win32.
Getting Started with CAN for Windows NT 4-2 © National Instruments Corporation



© National Instruments Corporation A-1 Getting Started with CAN
A

re 
the 
, 

. 
Uninstall the Hardware 
and Software

This appendix describes how to uninstall the CAN hardware and the 
NI-CAN software from Windows NT.

Uninstalling the CAN Hardware from Windows NT
Because the current version of Windows NT does not maintain hardwa
information for the CAN interfaces, you just need to physically remove 
CAN interfaces from your computer. To do so, shut down Windows NT
power off your computer, and physically remove the CAN interfaces.

Uninstalling the NI-CAN Software from Windows NT

Note The following instructions apply to Windows NT 4.0 only. If you are using 
Windows NT 3.51, refer to the readme.txt  file in your NI-CAN directory 
for information on how to uninstall the NI-CAN software.

Before uninstalling the NI-CAN software, you should remove all CAN 
interface hardware from your computer, as explained in the previous 
section.

Complete the following steps to remove the NI-CAN software:

1. Select the Add/Remove Programs icon under Start»Settings» 
Control Panel. A dialog box similar to the one in Figure A-1 appears
This dialog box lists the software available for removal.
 for Windows NT
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Figure A-1.  Add/Remove Programs Properties Dialog Box

2. Select the NI-CAN software you want to remove, and click on the 
Add/Remove button. The uninstall program runs and removes all 
folders, utilities, device drivers, DLLs, and registry entries associa
with the NI-CAN software. Figure A-2 shows the results of a 
successful uninstallation.
Getting Started with CAN for Windows NT A-2 © National Instruments Corporation
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Figure A-2.  NI-CAN Uninstallation Results

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directo
because the directory is not empty after the uninstallation. You need to
remove any remaining components yourself.

If you want to reinstall the hardware and software, refer to Chapter 2, 
Installation and Configuration.
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Cabling Requirements

This appendix describes the cabling requirements for CAN interfaces.

Cables should be constructed to meet these requirements, as well as 
requirements of the other CAN or DeviceNet devices in the network.

Connector Pinouts
Depending on the type of CAN interface you are installing, the CAN 
hardware either has DB-9 D-Sub connectors(s), or Combicon-style 
pluggable screw terminal connector(s). 

The 9-pin D-Sub follows the pinout recommended by CiA DS 102. 
Figure B-1 shows the pinout for this connector.

Figure B-1.  Pinout for 9-Pin D-Sub Connector

1
2

3
4

5

6
7

8
9

No Connection

CAN_L

V-

No Connection

Optional Ground (V-)

CAN_H

No Connection

V+
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The 5-pin Combicon-style pluggable screw terminal follows the pinout
required by the DeviceNet specification. Figure B-2 shows the pinout f
this connector. 

Figure B-2.  Pinout for 5-Pin Combicon-Style Pluggable Screw Terminal

CAN_H and CAN_L are signal lines that carry the data on the CAN 
network. These signals should be connected using twisted-pair cable.

The V+ and V– pins are used to supply bus power to the CAN physica
layer if external power is required for the CAN physical layer. If interna
power for the CAN physical layer is used, the V– pin serves as the refere
ground for CAN_H and CAN_L. See the next section, Power Supply 
Information for the CAN Ports, for more information.

Figure B-3 shows the end of a PCMCIA-CAN cable. The arrow points 
pin 1 of the 5-pin screw terminal block. All of the signals on the 5-pin 
Combicon-style pluggable screw terminal are connected directly to the
corresponding pins on the 9-pin D-Sub.

Figure B-3.  PCMCIA-CAN Cable
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Power Supply Information for the CAN Ports
For the PCI-CAN and PCI-CAN/2, the power source for the CAN physic
layer is configured with a jumper. For the PCI-CAN and port one of the
PCI-CAN/2, power is configured with jumper J6. For port two of the 
PCI-CAN/2, power is configured with jumper J5. The location of these
jumpers is shown in Figure B-4.

Figure B-4.  PCI-CAN/2 Power Source Jumpers

Connecting pins 1 and 2 of a jumper configures the CAN physical laye
be powered externally (from the bus cable power). In this configuration,
power must be supplied on the V+ and V– pins on the port connector.

Connecting pins 2 and 3 of a jumper configures the CAN physical laye
be powered internally (from the card). In this configuration, the V– sign
serves as the reference ground for the isolated signals.

1 Power Supply Jumper J6
2 Product Name

3 Serial Number
4 Assembly Number

5 Power Supply Jumper J5

3

5 4

1 2
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Figure B-5 shows how to configure your jumpers for internal or externa
power supplies.

Figure B-5.  Power Source Jumpers

The CAN physical layer is still isolated regardless of the power source
chosen.

The PCMCIA-CAN and PCMCIA-CAN/2 are available with two types o
cable. The DeviceNet (bus powered) cable requires that the CAN phys
layer be powered from the bus cable power.

The internal-powered cable supplies power to the CAN physical layer fr
the host computer. The V+ pin is not connected to any internal signals
the corresponding pins on the 9-pin D-Sub and the 5 pin Combicon-st
connectors are still connected. The V– pins serves as the reference gr
for the isolated signals.

The CAN physical layer is isolated from the computer in both types of 
cable.

Bus Power Supply Requirements
If the CAN physical layer is powered from a bus power supply, the pow
supply should be a DC power supply with an output of 10 V to 30 V. T
power requirements for the CAN ports for Bus-Powered configurations 
shown in Table B-1. You should take these requirements into account w
determining requirements of the bus power supply for the system.

Table B-1.  Power Requirements for the CAN Physical Layer for 
Bus-Powered Versions

Characteristic Specification

Voltage Requirement V+ 10-30 VDC

Current Requirement 40 mA typical 
100 mA maximum

INT EXT

a. Internal Power Mode

INT EXT

b. External Power Mode
(Device Net)

123 123
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Cable Specifications
Cables should meet the physical medium requirements specified in 
ISO 11898, shown in Table B-2.

Belden cable (3084A) meets all of those requirements, and should be
suitable for most applications.

Cable Lengths
The allowable cable length is affected by the characteristics of the cab
and the desired bit transmission rates. Detailed cable length requirem
can be found in the ISO 11898, CiA DS 102, and DeviceNet specificati

ISO 11898 specifies 40 m total cable length with a maximum stub leng
of 0.3 m for a bit rate of 1 Mb/s. The ISO 11898 specification says tha
significantly longer cable lengths may be allowed at lower bit rates, bu
each node should be analyzed for signal integrity problems.

Table B-3 lists the DeviceNet cable length specifications.

Table B-2.  ISO 11898 Specifications for Characteristics of a CAN_H and 
CAN_L Pair of Wires

Characteristic Value

Impedance 108 Ω minimum, 120 Ω nominal, 
132 Ω maximum

Length-related resistance 70 mΩ/m nominal

Specific line delay 5 ns/m nominal

Table B-3.  DeviceNet Cable Length Specifications

Bit Rate Thick Cable Thin Cable

500 kb/s 100 m 100 m

250 kb/s 200 m 100 m

100 kb/s 500 m 100 m
© National Instruments Corporation B-5 Getting Started with CAN for Windows NT
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Maximum Number of Devices
The maximum number of devices that you can connect to a CAN port 
depends on the electrical characteristics of the devices on the network.
of the devices meet the requirements of ISO 11898, at least 30 devices
be connected to the bus. Higher numbers of devices may be connected
electrical characteristics of the devices do not degrade signal quality be
ISO 11898 signal level specifications. If all of the devices on the netwo
meet the DeviceNet specifications, 64 devices may be connected to th
network.

Cable Termination
The pair of signal wires (CAN_H and CAN_L) constitutes a transmissi
line. If the transmission line is not terminated, each signal change on t
line causes reflections that may cause communication failures.

Because communication flows both ways on the CAN bus, CAN requi
that both ends of the cable be terminated. However, this requirement d
not mean that every device should have a termination resistor. If multi
devices are placed along the cable, only the devices on the ends of the
should have termination resistors. See Figure B-6 for an example of w
termination resistors should be placed in a system with more than two
devices.

Figure B-6.  Termination Resistor Placement

The termination resistors on a cable should match the nominal impeda
of the cable. ISO 11898 requires a cable with a nominal impedance of
120Ω; therefore, a 120 Ω resistor should be used at each end of the cab
Each termination resistor should each be capable of dissipating 0.25 W
power.

120 Ω 120 Ω

CAN_H

CAN_L
CAN

Device

CAN
Device

CAN
Device

CAN
Device
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Cabling Example
Figure B-7 shows an example of a cable to connect two CAN devices.
the internal power configuration, no V+ connection is required.

Figure B-7.  Cabling Example

9-Pin
D-Sub

9-Pin
D-Sub

CAN_H

CAN_L

GND

V+

V+

V–

V–

5-Pin
Combicon

5-Pin
Combicon

Pin 7Pin 4 Pin 7 Pin 4

Pin 2 Pin 2

Pin 5 Pin 3

Pin 9 Pin 5

Pin 3 Pin 1

Pin 2Pin 2

Pin 5Pin 3

Pin 9Pin 5

Pin 3Pin 1

120Ω 120Ω

Power
Connector
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Troubleshooting and 
Common Questions

This appendix describes how to troubleshoot problems and answers s
common questions.

Missing CAN Interface in the NI-CAN Configuration 
Utility

The NI-CAN Configuration utility contains configuration information for
all of the CAN hardware it is aware of that is installed in your system. 
start the NI-CAN Configuration utility, double-click on the NI-CAN  
Configuration  icon in the Control Panel:

• Windows NT 3.51: Open the Control Panel in the Main group of 
theProgram Manager.

• Windows NT 4.0 or later: Select Start»Settings»Control Panel.

If the CAN interface you are looking for is not listed under NI-CAN 
Configuration , the CAN interface is not properly installed. For Nationa
Instruments CAN hardware, this means that the interface is not physic
present in the system. If the interface is firmly plugged into its slot and 
problem persists, contact National Instruments.

Troubleshooting Diagnostic Utility Failures
The following sections explain common error messages generated by
NI-CAN Diagnostic utility.

Resource Errors
This error occurs if the memory resource or interrupt resource assigne
a CAN interface conflicts with the resources being used by other devic
in the system. If a resource error occurs, click on the Resources button 
in the NI-CAN Configuration utility to view the board resources. For the
PCMCIA-CAN, change the conflicting resource shown in Resources until 
 for Windows NT
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the interface passes the diagnostic test. For the PCI-CAN, if legacy bo
in your system are using the resources, change the resource configura
of the legacy board. If the problem persists, contact National Instrume

NI-CAN Software Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects that it is unab
to communicate correctly with the CAN hardware using the installed 
NI-CAN software. If you get this error, shut down your computer, restart
and run the NI-CAN Diagnostic utility again. If the problem persists, try
reinstalling the NI-CAN software for Windows NT. 

Missing CAN Interface
If a National Instruments CAN interface is physically installed in your 
system, but is not listed in the NI-CAN Diagnostic utility, check to see 
the NI-CAN Configuration utility has detected the hardware. For more 
information, refer to the Missing CAN Interface in the NI-CAN 
Configuration Utility section earlier in this appendix.

CAN Hardware Problem Encountered
This error occurs if the NI-CAN Diagnostic utility detects a defect in th
CAN hardware. If you get this error, write down the numeric code show
with the error, and contact National Instruments. Depending on the ca
of the hardware failure, you may need to repair or replace your CAN 
interface.

Common Questions
How can I determine which type of CAN hardware I have installed?

Run the NI-CAN Configuration utility. To run the utility, select 
Start»Settings»Control Panel»NI-CAN Configuration. If any CAN 
hardware is correctly installed, it is listed under National Instruments 
CAN Interfaces.

How do I connect a CAN cable to my CAN interface?

For information about cabling requirements for National Instruments 
CAN hardware, refer to Appendix B, Cabling Requirements.
Getting Started with CAN for Windows NT C-2 © National Instruments Corporation
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How can I determine which version of the NI-CAN software I have 
installed?

Run the NI-CAN Diagnostic utility. To run the utility, select the NI-CAN 
Diagnostic item under Start»Programs»NI-CAN Software for 
Windows NT. The NI-CAN Diagnostic utility displays information about
the version of the NI-CAN software currently installed.

Which CAN interfaces does the NI-CAN software for Windows NT 
support?

The NI-CAN software for Windows NT supports the PCI-CAN, 
PCI-CAN/2, PCMCIA-CAN, and PCMCIA-CAN/2.

What do I do if the NI-CAN Diagnostic utility fails with an error?

Refer to the Troubleshooting Diagnostic Utility Failures section in this 
appendix for specific information about what might cause the NI-CAN 
Diagnostic utility to fail. If you have already completed the troubleshooti
steps, fill out the forms in Appendix E, Customer Communication, and 
contact National Instruments.

How many CAN boards can I configure for use with my NI-CAN 
software for Windows NT? 

The NI-CAN software for Windows NT can be configured to communica
with up to 10 CAN boards. 

Are interrupts required for the NI-CAN software for Windows NT?

Yes, one interrupt per board is required.

How do I use an NI-CAN language interface?

For information about using NI-CAN language interfaces, refer to 
Chapter 3, Developing Your Application, in the NI-CAN User Manual for 
Windows 95 and Windows NT.

How do I use NI-CAN from within LabVIEW?

For information about using NI-CAN from within LabVIEW, refer to 
Chapter 3, Developing Your Application, in the NI-CAN User Manual 
for Windows 95 and Windows NT.
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Why does the uninstall program leave some components installed?

The uninstall program removes only items that the installation program
installed. If you add anything to a directory that was created by the 
installation program, the uninstall program does not delete that directo
because the directory is not empty after the uninstallation. You must 
remove any remaining components yourself.

What information should I have before I call National Instruments?

When you call National Instruments, you should have all of the informat
filled out on the Hardware and Software Configuration Form in 
Appendix E, Customer Communication.
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Specifications

This appendix describes the physical characteristics of the CAN hardw
along with the recommended operating conditions.

Table D-1.  PCI-CAN and PCI-CAN/2 Hardware Characteristics

Characteristic Specification

Dimensions 10.67 by 17.46 cm
(4.2 by 6.88 in.)

Power Requirement +5 VDC 775 mA typical

I/O Connector 9-pin D-Sub for each port (standard)
or
5-pin Combicon-style pluggable 
DeviceNet screw terminal

Operating Environment
Ambient Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing
 for Windows NT
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Table D-2.  PCMCIA-CAN and PCMCIA-CAN/2 Hardware Characteristics

Characteristic Specification

Dimensions 8.56 by 5.40 by 0.5 cm
(3.4 by 2.1 by 0.4 in.)

Power Requirement 500 mA typical

I/O Connector Cable with 9-pin D-Sub and 5-pin 
Combicon-style pluggable screw 
terminal for each port

Operating Environment
Component Temperature
Relative Humidity

0° to 55° C
10% to 90%, noncondensing

Storage Environment
Temperature
Relative Humidity

–20° to 70° C
5% to 90%, noncondensing

Table D-3.  CAN Port Characteristics for Bus-Powered Ports

Characteristic Specification

Power Requirement 10-30 V 40 mA typical
100 mA maximum

Isolation 500 VDC optical
Getting Started with CAN for Windows NT D-2 © National Instruments Corporation
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessa
to help us solve your technical problems and a form you can use to comment on the product 
documentation. When you contact us, we need the information on the Technical Support Form
the configuration form, if your manual contains one, about your system configuration to answer
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to
provide the information you need. Our electronic services include a bulletin board service, an FT
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first 
electronic support systems. If the information available on these systems does not answer you
questions, we offer fax and telephone support through our technical support centers, which are
by applications engineers. 

Electronic Services

Bulletin Board Support
National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of
and documents to answer most common customer questions. From these sites, you can also d
the latest instrument drivers, updates, and example programs. For recorded instructions on how
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. Yo
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom:  01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France:  01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support
To access our FTP site, log on to our Internet host, ftp.natinst.com , as anonymous  and use 
your Internet address, such as joesmith@anywhere.com , as your password. The support files and
documents are located in the /support  directories.
 for Windows NT
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Fax-on-Demand Support
Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a
range of technical information. You can access Fax-on-Demand from a touch-tone telephone a
512 418 1111.

E-Mail Support (Currently USA Only)
You can submit technical support questions to the applications engineering team through e-mai
Internet address listed below. Remember to include your name, address, and phone number so
contact you with solutions and suggestions. 

support@natinst.com

Telephone and Fax Support
National Instruments has branch offices all over the world. Use the list below to find the technic
support number for your country. If there is no National Instruments office in your country, cont
the source from which you purchased your software to obtain support.

Country Telephone Fax
Australia 03 9879 5166 03 9879 6277
Austria 0662 45 79 90 0 0662 45 79 90 19
Belgium 02 757 00 20 02 757 03 11
Brazil 011 288 3336 011 288 8528
Canada (Ontario) 905 785 0085 905 785 0086
Canada (Quebec) 514 694 8521 514 694 4399
Denmark 45 76 26 00 45 76 26 02
Finland 09 725 725 11 09 725 725 55
France 01 48 14 24 24 01 48 14 24 14
Germany 089 741 31 30 089 714 60 35
Hong Kong 2645 3186 2686 8505
Israel 03 6120092 03 6120095
Italy 02 413091 02 41309215
Japan 03 5472 2970 03 5472 2977
Korea 02 596 7456 02 596 7455
Mexico 5 520 2635 5 520 3282
Netherlands 0348 433466 0348 430673
Norway 32 84 84 00 32 84 86 00
Singapore 2265886 2265887
Spain 91 640 0085 91 640 0533
Sweden 08 730 49 70 08 730 43 70
Switzerland 056 200 51 51 056 200 51 55
Taiwan 02 377 1200 02 737 4644
United Kingdom 01635 523545 01635 523154
United States 512 795 8248 512 794 5678
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Technical Support Form
Photocopy this form and update it each time you make changes to your software or hardware, a
the completed copy of this form as a reference for your current configuration. Completing this f
accurately before contacting National Instruments for technical support helps our applications 
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem
include the configuration forms from their user manuals. Include additional pages if necessary.

Name ______________________________________________________________________

Company ___________________________________________________________________

Address ____________________________________________________________________

___________________________________________________________________________

Fax ( ___ ) ________________Phone ( ___ ) ______________________________________

Computer brand____________ Model ___________________Processor _____________________

Operating system (include version number) ________________________________________

Clock speed ______MHz   RAM _____MB Display adapter ________________________

Mouse ___yes   ___no     Other adapters installed ___________________________________

Hard disk capacity _____MB Brand______________________________________________

Instruments used _____________________________________________________________

___________________________________________________________________________

National Instruments hardware product model _____________ Revision  ____________________

Configuration _______________________________________________________________

National Instruments software product ___________________  Version  _____________________

Configuration _______________________________________________________________

The problem is: ______________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

List any error messages: _______________________________________________________

___________________________________________________________________________

___________________________________________________________________________

The following steps reproduce the problem: _______________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________

___________________________________________________________________________



h item. 
, and 
ore 
your 

___

__

__

____

____

____

____

___

___

__

____
Hardware and Software Configuration Form
Record the settings and revisions of your hardware and software on the line to the right of eac
Complete a new copy of this form each time you revise your software or hardware configuration
use this form as a reference for your current configuration. Completing this form accurately bef
contacting National Instruments for technical support helps our applications engineers answer 
questions more efficiently.

National Instruments Products
General Information
CAN Interface Type (such as PCI-CAN/2) _________________________________________

NI-CAN Diagnostic Utility Results ________________________________________________

Version Information
To access complete version information, including the hardware version and the NI-CAN 
driver version, open the MS-DOS Prompt and change to the NI-CAN installation directory 
(usuallyc:\nican ). At the prompt, enter the following command:

candiag -v

Version Information from the NI-CAN Diagnostic ____________________________________

___________________________________________________________________________

Other Products
Programming Environment Information

Programming Language _______________________________________________________

Compiler Vendor_____________________________________________________________

Compiler Version ____________________________________________________________

Application Information

LabVIEW Application _________________________________________________________

Win32 Application ____________________________________________________________

If Win 32, method of accessing DLL (link with language interface or direct entry?) __________

___________________________________________________________________________



____
Documentation Comment Form
National Instruments encourages you to comment on the documentation supplied with our products. 
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your CAN Hardware and the NI-CAN™ Software 

for Windows NT

Edition Date: January 1998

Part Number: 321372C-01

Please comment on the completeness, clarity, and organization of the manual.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

If you find errors in the manual, please record the page numbers and describe the errors.

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

_______________________________________________________________________________

Thank you for your help.

Name _________________________________________________________________________

Title ______________________________________________________________________

Company _______________________________________________________________________

Address ________________________________________________________________________

_______________________________________________________________________________

E-Mail Address__________________________________________________________________

Phone ( ___ ) __________________________  Fax ( ___ ) _______________________________

Mail to: Technical Publications Fax to: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512 794 5678
Austin, Texas 78730-5039



Glossary
Prefix Meanings Value

n- nano- 10–9

m- milli- 10–3

c- centi- 10–2

k- kilo- 103

M- mega- 106

° degrees

Ω ohms

% percent

A amperes

AC alternating current

ANSI American National Standards Institute

AT-compatible compatible with the 16-bit Industry Standard Architecture

b bits

B bytes

C Celsius

CAN Controller Area Network

CiA CAN in Automation

DLL dynamic link library

DMA direct memory access

EMI electromagnetic interference

FCC Federal Communications Commission

Hz hertz

IEEE Institute of Electrical and Electronic Engineers
© National Instruments Corporation G-1 Getting Started with CAN for Windows NT



Glossary

ding 
uch 
in. inches

IRQ interrupt request

ISA Industry Standard Architecture

ISO International Standards Organization

m meters

PC personal computer

PCI peripheral component interconnect

PCMCIA Personal Computer Memory Card International Association

RAM random-access memory

resource hardware settings used by National Instruments CAN hardware, inclu
an interrupt request level (IRQ) and an 8 KB physical memory range (s
as D0000 to D1FFF hex)

s seconds

V volts

VDC volts direct current

W watts
Getting Started with CAN for Windows NT G-2 © National Instruments Corporation
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